Notes on Writing, Typesetting, and Word Processing

Karl Hammond
Chemical Engineering 401: Chemical Engineering Laboratory

October 2009
Tales of Interest

- **Scientific writing**
  - General comments
  - Abstracts
  - Figures & tables
  - Document structure
  - Citations and Bibliographies
  - Math
- **Using MS-Word effectively**
- **Your next report**
You can write 160°C instead of “one hundred sixty degrees Celsius”

Percent signs (esp. at end of sentence)

Use of words
- Too, to, and two
- Is vs. was: Saying “maintaining X is important…” vs. “maintaining X was important”

Superscripts and subscripts: $x_2$ vs. $x2$ (difference is *clarity*);

If I (KDH) didn’t write anything in a particular paragraph, I probably didn’t *read* it
General Comments

- Comma use; which of these is the most common in your reports? Correct? Preferred?
  1. In this paper life, the universe, and everything are discussed.
  2. In this paper, life, the universe, and everything are discussed.
  3. In this paper we discuss life, the universe, and everything.
  4. In this paper, we discuss life, the universe, and everything.
  5. We discuss life, the universe, and everything in this paper.
Comma use; which of these is the most common in your reports? Correct? Preferred?

1. In this paper life, the universe, and everything are discussed.
2. In this paper, life, the universe, and everything are discussed.
3. In this paper we discuss life, the universe, and everything.
4. In this paper, we discuss life, the universe, and everything.
5. We discuss life, the universe, and everything in this paper.
Comma use; which of these is the most common in your reports? Correct? Preferred?

1. In this paper life, the universe, and everything are discussed.
2. In this paper, life, the universe, and everything are discussed.
3. In this paper we discuss life, the universe, and everything.
4. In this paper, we discuss life, the universe, and everything.
5. We discuss life, the universe, and everything in this paper.
Comma use; which of these is the most common in your reports? Correct? Preferred?

1. In this paper life, the universe, and everything are discussed.
2. In this paper, life, the universe, and everything are discussed.
3. In this paper we discuss life, the universe, and everything.
4. In this paper, we discuss life, the universe, and everything.
5. We discuss life, the universe, and everything in this paper.
Titles

- Title is all most people ever read.
- Short, concise, meaningful
- Should tell us what to expect
- Very general
- Stands alone
Abstracts

- Often the *only* thing read other than the title (if that)

- Should contain
  - Essential motivation
  - Problem statement
  - Approach
  - Results
  - Implications of results

- Try to entice the reader to read the document

- **One** paragraph.
Figures

- Graph/diagram appearance
  - No distracting elements (borders, titles, grid lines, ...)
  - Must be readable
  - Minimal or NO use of color

\[
y = 0.8573x + 0.9182 \\
R^2 = 0.9808
\]
Captions should show:
- What you’re showing
- What it tells you
- Why it’s important

Example 1: Bad caption

Figure 1. Conversion vs. time.
Captions

- Captions should show:
  - What you’re showing
  - What it tells you
  - Why it’s important

- Example 2: Better caption

Figure 1. Conversion of $A$ as a function of time (points) compared to an ideal, zero-order batch reaction (solid line). This indicates that the reaction of $A$ with $B$ is zero order in $A$, suggesting that the model in Equation (1) is correct.
Tables

- Tables are difficult to present cleanly
- Tables also have captions (usually at the top!)
- Use the structure to help; don’t force it!
  - Minimal horizontal/vertical rules
  - Don’t put too much information in one cell

Table 5. Heat transferred and outlet temperatures as a function of cooling water flow rate. The trends are consistent with really bogus heat transfer, suggesting these results are fabrications.

<table>
<thead>
<tr>
<th>Flow rate (mL/min)</th>
<th>$T_{CW,\text{out}}$ ($^\circ$C)</th>
<th>$T_{PW,\text{out}}$ ($^\circ$C)</th>
<th>$Q$ (kJ/kg)</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.4</td>
<td>135.3</td>
<td>173.4</td>
<td>45.4</td>
</tr>
<tr>
<td>12.6</td>
<td>140.1</td>
<td>170.3</td>
<td>50.3</td>
</tr>
<tr>
<td>22.4</td>
<td>143.2</td>
<td>167.8</td>
<td>53.6</td>
</tr>
<tr>
<td>28.3</td>
<td>153.7</td>
<td>163.9</td>
<td>65.3</td>
</tr>
</tbody>
</table>
Document Structure

- Several layers to a (short) document
  - Sections
  - Subsections
  - Sub-subsections
  - Paragraphs
  - Sub-paragraphs
  - 1 Background
  - 1.3 Theory of Catalytic Kinetics
  - 1.3.1 Langmuir Isotherm
  - Derivation of Langmuir Isotherm
  - [not typically used]

- All can be numbered or non-numbered.

- Discussion of similar topics that need separation? Try a subsection!
Conclusions

- Summary should state conclusions
- Abstract should state conclusions
- Conclusions at end of report (usually)

Bibliographies

- Need to report *all information* necessary and any other information the publisher wants:
  - First author’s name and other authors
  - Year of publication
  - Title of source
  - Page number(s) (for chapters or articles)
  - Volume/Edition numbers (if appropriate)
  - Issue number
  - Article title
  - Publisher and address (for books)
Bibliographies

- There is no “correct” bibliography style
- Several “accepted” styles to choose from
  - ACS

**Journal/magazine article**
Hammond, K. D.; Hong, M.; Tompsett, G. A.; Auerbach, S. M.; Falconer, J. L.; Conner, W. C. J.

*Membr. Sci.* **2008**, *325*, 413–419.

**Book**

**Book Chapter**

**Thesis/Dissertation** (thesis => master of XXX; dissertation => doctor of XXX)
There is no “correct” bibliography style
Several “accepted” styles to choose from
• AIChE (old)

Journal/magazine article

Book

Book Chapter

Thesis/Dissertation  (thesis => master of XXX; dissertation => doctor of XXX)
Bibliographies

- There is no “correct” bibliography style
- Several “accepted” styles to choose from
  - AIChe (new)

Journal/magazine article

Book

Book Chapter

Thesis/Dissertation (thesis => master of XXX; dissertation => doctor of XXX)
There is no “correct” bibliography style
Several “accepted” styles to choose from
  • Elsevier/Academic Press

Journal/magazine article

Book

Book Chapter

Thesis/Dissertation (thesis => master of XXX; dissertation => doctor of XXX)
Citations

- Citations should be to primary sources

- Web sites (esp. Wikipedia) should be avoided

- Two styles:
  - Numerical
  - Author–date

Numerical:

According to Newton [1], force is proportional to acceleration. His subsequent laws of gravitation [2–5] changed astronomy forever.

According to Newton, force… of gravitation2–5 changed astronomy forever.

Note that it is not [2][3][4][5] or [2,3,4,5].

Bibliography in order references appear in the text.
Citations should be to primary sources

Web sites (esp. Wikipedia) should be avoided

Two styles:
- Numerical
- Author–date

Author–Date:

According to Newton (1620a), force is proportional to acceleration. His subsequent laws of gravitation (Newton, 1621ab, 1622a, 1623) changed astronomy forever.

Letters denote multiple entries in the bibliography with the same first author in the same year.

Bibliography sorted alphabetically.
How does one refer to a table, figure, equation, etc. in the text?

Two options

- Use “above” and “below”
- Say “Equation (3)” or “Figure 1”

Cross-references (and citations) should not break lines before the number!

These trends are shown in Figure 2.

These trends are shown in Figure 2.

vide infra, see below  
vide supra, see above
Latin abbreviations you’ll encounter:

- *et al.* (*et alii, et alia, et alibi*): and others, and other things, and other places
- *i.e.* (*id est*): that is
- *e.g.* (*exempli gratia*): for example
- *ibid.* (*ibidem*): In the same place
- *op. cit.* (*opere citato*): In the same [article,book] mentioned before
- *id.* (*idem*): The same [person]
- *vide infra/supra*: see below/above
- *c. (circa)*: around (about, approximately)
- *cf. (confer)*: compare [to]
- *viz. (videlicet)*: “to wit” or “namely”
- *etc. (et cetera)*: and other things
- *lb. (libra)*: scales (or “pounds”)
- *sic*: thus (*e.g.*, “Professor Connor [*sic*] is our teacher.”)
Math symbols are usually italicized:
“The symbol $T$ is used here for temperature.”

Equations can be numbered for ease of cross-referencing:
The roots of the quadratic formula are well known, and can be found by the simple formula

$$x = \frac{-b \pm \sqrt{b^2 - 4ac}}{2a}$$  \hspace{1cm} (1)

With these in hand, we are ready to conquer the world. Equation (1) is the basis of all solutions we will ever need for world domination.
Tales of Interest

- Scientific writing
  - General comments
  - Abstracts
  - Figures & tables
  - Document structure
  - Citations and Bibliographies
  - Math
- Using MS-Word effectively
- Your next report
What MS-Word is

- **Microsoft Word is**
  - A word processing program
  - WYSI(A)WYG (what you see is [almost] what you get)

- **Microsoft Word is not**
  - A professional typesetter
  - Designed by a professional typesetter
  - Designed with scientific writing in mind
  - Good at handling images
  - Portable

“Daddy, why do they call it a word processor?”

“Well, son, you’ve seen what a food processor does to food, right?”
Symbols

- Word has most symbols built in
  Degrees sign, minus sign, accents, arrows, Greek, non-breaking spaces, ...
Symbols to worry about:

- Degrees sign (CTRL-SHIFT-@, space)
- En dash (CTRL+SHIFT+- [on numeric keypad])
  - Langmuir–Hinshelwood vs. Langmuir-Hinshelwood
  - Pages 8–9 vs. Pages 8-9
- Em dash (CTRL+ALT+- [on keypad]); often works to type two hyphens, --
- Non-breaking space (CTRL-SHIFT-Space)
  - Keeps “Figure 1” from breaking between ‘e’ and ‘1’
  - Should be used any time you wish to keep two things together on a line
- Non-breaking hyphen (CTRL-SHIFT-_)
- Page break (CTRL-Enter)
Formatting on-the-fly

- **Bold**: CTRL-B
- **Italic**: CTRL-I
- **Underline**: CTRL-U

- **Superscript**: CTRL-=
- **Subscript**: CTRL++ (CTRL-SHIFT-=)

- **Page break**: CTRL-Enter
- **Line break**: Shift-Enter
Equations

- Enter equations using Microsoft Equation Editor
Equation Editor

- Use the toolbar to select symbols or
  - Parentheses (expandable!): CTRL-9 OR CTRL-0
  - Fractions: CTRL-f
  - Greek: CTRL-g, [letter] Ex: Ctrl-g, m → µ
  - Subscript: CTRL-h
  - Superscript: CTRL-ℓ
  - Integrals: CTRL-i OR CTRL-t, i
  - Roots: CTRL-t, n
  - Sums: CTRL-t, s

- Can enter *most* mathematical objects and scale them to any desired size.
Tabbing

- Setting tabs is useful for equations:
Equations

- Three ways to set equations

Here's some text to show you what justified text looks like above an equation, just so you can see the three types of styles really easily without embellishment

\[
\frac{\partial \rho}{\partial t} + \nabla \cdot \rho \vec{v} = 0
\]

1

Here's more text that covers the line just for the sake of having filler

\[
\frac{\partial \rho}{\partial t} + \nabla \cdot \rho \vec{v} = 0
\]

2

And here's the third type with lots and lots and lots and lots of extra text to fill out the line

\[
\frac{\partial \rho}{\partial t} + \nabla \cdot \rho \vec{v} = 0
\]

3

- Long documents: Equation (1.2), where 1 is the chapter number and 2 is the equation number.
Many ways to produce automatic numbering in Word

- All are based on Field Codes
- Some are more reliable than others
- My favorite is the SEQ field
- Insert → Reference → Cross-reference is NOT generally robust.
Sequence (SEQ) Fields
Updating Fields

- **Fields only update**
  - When the document is loaded
  - When the document is printed (careful!)
  - When “Update Field” is selected from the right-click menu
  - When “F9” (update fields) is pressed

- Either reload the document or press CTRL-A (select all), F9 (update fields) to update all fields
More on Sequences

- The SEQ field can give you Arabic or Roman numerals or Roman alphabetical sequences
  - Default is Arabic numerals
  - Click the Options tab to change the number appearance

- One can reset the counter, skip an item, or go back an item using the Options tab
Bookmarks

- Bookmarks can be used for referring to an auto-generated number
- Refer to bookmarks using the \texttt{Ref} field
- Generate the page number with the \texttt{Pageref} field
Styles

- Word will auto-number sections if you wish
- Do this by Styles
- Insert cross-references by the bookmark/Ref field combination.
Once you have style-based section headings in place, Word will create a table of contents for you!

Can also generate lists of tables and figures